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1 Einführung
Dieses 5-stündige Präsenzmodul führt anhand einfacher Beispiele in die Nutzung der Stickplattform
InkStitch ein. Für weitere Details konsultieren Sie bitte das offizielle Handbuch 1, insbesondere die
Sticharten-Bibliothek 2. Dieser Text ist kein Tutorial, sondern dient als direkte Unterstützung für ei-
nen Präsenzkurs.
Lernziele

1. Grundprinzipien der Maschinenstickerei nennen
2. Einfache Füllstiche erstellen mit Ink/Stitch
3. Geradstiche erstellen mit Ink/Stitch
4. Satinstiche erstellen mit verschiedenen Methoden
5. Beschriftenmit Ink/Stitch
6. Grundmanipulationen der Vektorgrafikmit Inkscape
7. Stickobjekte ordnen
8. Simulation und Überprüfung des Designs
9. Stickmaschine verwenden

10. Andere Füllmethoden identifizieren

1.1 Wichtige Ink/Stitch- und Inkscape-Ressourcen
— Starter-Pack (Bitte herunterladen und entpacken)

— Enthält „default.xml”, eine kleine Gunold-Palette, Abzeichenmotive und Clipart, die wir im
Kurs brauchen

— ZIP herunterladen : https://arbores.tech/e/inkstitch/starter-pack/starter-pack.
zip

— Web-Datei (alternativ) : https://arbores.tech/e/inkstitch/starter-pack/

— Offizielle Dokumentation von Ink/Stitch3, zum Beispiel :
— Benutzerhandbuch4 oder User manual5 (en.)
— Arbeitsablauf6

— Inkscape (Zeichnen, Bearbeitung von Pfaden)
— Bearbeiten Sie die Tutorials 1–4, die im Menü „Hilfe” von Inkscape (oben rechts) verfügbar

sind

— Frei verwendbare Medien : siehe Links am Ende

1.2 Grundprinzipien der Maschinenstickerei
Die ersten Sticksoftware-Programme zwangen die Benutzenden, den Stich Punkt für Punkt zu defi-
nieren – eine lange und mühsame Arbeit.
Die moderne Sticksoftware funktioniert nach einem anderen Prinzip : Eine Zeichnung wird aus Sti-
ckobjekten zusammengesetzt. Ein Stickobjekt definiert sowohl eine Form als auch die Art undWeise,
wie sie gestickt werden soll. Die erzeugten Grundstiche sind der Geradstich, der Satin-Stich und der

1. https://inkstitch.org/de/docs/install/
2. https://inkstitch.org/de/docs/stitch-library/
3. http://inkstitch.org
4. https://inkstitch.org/de/docs/install/
5. https://inkstitch.org/docs/install/
6. https://inkstitch.org/de/docs/workflow/
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Füllstich (oder Tatami-Stich). Sobald die Designphase abgeschlossen ist, wird die Zeichnung in eine
Maschinendatei exportiert, die von der Stickmaschine verwendetwird, umdie Stickerei auszuführen.
Wie Sie feststellen werden, gibt es mehrere Wege, ein stickbares Design aus einer Zeichnung oder
einer Idee zu erstellen. Dabei unterscheidet man zwei Hauptansätze : die klassische Digitalisierung
und die halbautomatische Digitalisierung.
1) Der Workflow (Arbeitsprozess) der klassischen Digitalisierung ist vergleichsweise übersicht-
lich :
Mit einer Sticksoftware, die Digitalisierung ermöglicht, zeichnet man direkt Stickobjekte, wobei bes-
timmte Grundprinzipien zu beachten sind, die im Kurs erläutert werden. Insbesondere muss darauf
geachtet werden, die Objekte in der richtigen Reihenfolge anzuordnen und keine großen Überlap-
pungen zu erzeugen.
Ein Stickobjekt ist zunächst eine geometrische Form. Dieses Objekt definiert jedoch auch den zu ver-
wendenden Stickstich (zum Beispiel einen Tatami-Stich) sowie eine Reihe von Parametern, die festle-
gen, wie dieser Stich gestickt wird (zum Beispiel Dichte, Winkel oder Stichlänge). Diese Definitionen
ermöglichen es, den Maschinencode zu erzeugen, insbesondere die Stellen, an denen die Maschine
einstechen muss.
2) Der typische Workflow der halbautomatischen Digitalisierung ausgehend von einer Zeich-
nung folgt in der Regel diesen Schritten :

— Eine Zeichnung erstellen (vonHand odermit einer Zeichensoftware) oder ein Bild herunterladen.
— Bei manchen Programmen muss das Bild zunächst in ein Vektorformat umgewandelt werden,

wenn es ursprünglich rasterbasiert ist.
— Die Zeichnung an dieRandbedingungen der Stickerei anpassen (zu feine Details entfernen, An-

zahl der Farben reduzieren). Dieser Schritt kann auch direkt in der Sticksoftware erfolgen, wenn
sie ein Zeichenmodul enthält.

— Die Zeichnung in eine Sticksoftware importieren. Bei Programmen für den breiten Markt muss
die Zeichnung zuvor als hochauflösendes *.PNG exportiert werden, da diese Werkzeuge Vektor-
dateien oft schlecht verarbeiten und kein direktes Zeichnen in der Benutzeroberfläche erlauben.

— Die Zeichnungdurch einenDigitalisierungsprozess (engl.digitizing oderpunching) in „Stickob-
jekte” umwandeln. Zur Erinnerung : Ein Stickobjekt definiert einen Bereich, dermit automatisch
generiertenStichengefülltwird, entsprechendverschiedener vomBenutzer gewählter oder stan-
dardmäßig vorgegebener Parameter.

— (Optional) Schriftzüge hinzufügen, indem bereits digitalisierte Schriftarten verwendet werden.
— Die Stickobjekte anpassen oder neu parametrisieren (Sticharten, Dichte, Unterlage, Füllmus-

ter, Stichreihenfolge, Konturen usw.).
— Die Entwurfsdatei in einmaschinenkompatibles Format exportieren (.pes, .art, .jef, .dst usw.).
— Die Stickerei ausführen (Rahmen wählen, einspannen, Garne auswählen usw.).

1.3 Funktionsweise von Ink/Stitch
— Ink/Stitch ist eine Erweiterung (Extension) für Inkscape, ein Programm für Vektorgrafik.

— Ink/Stitch ermöglicht es, über die Benutzeroberfläche Stickparameter zu einem SVG-Objekt
hinzuzufügen, die definieren, wie es in Stickstiche „übersetzt” wird. Dieses Objekt sollte ein
SVG-Element vom Typ „path” (auf Deutsch : „Pfad”) sein.

— Eine Engine übersetzt anschließend diese parametrisierten Objekte in einen Stickplan (der als
Simulation angezeigt werden kann). Dieser Plan definiert alle Stiche, die die Maschine ausfüh-
ren muss. Der Plan wird anschließend in ein maschinenlesbares Format exportiert, zum Beispiel
*.PES, *.JEF oder *.DST.

— SVG ist Teil von HTML5. Man kann daher eine Inkscape/Ink/Stitch-Datei in einem Webbrowser
öffnen und die Zeichnung sehen (nicht jedoch die Sticksimulation). Mit Strg+U (‚Seitenquelltext
anzeigen') lässt sich der SVG-Code einsehen.

— Hinweis für Informatiker :SVGbasiert aufXMLund ist daher erweiterbar. Inkscapeund Ink/Stitch
fügen ihre eigenen Erweiterungen hinzu und verwenden dafür Namensräume, die amAnfang der
Datei deklariert werden. Beachten Sie, dass frühe Versionen von Ink/Stitch nicht konforme Attri-
bute (ohne Namespace-Deklaration) hinzugefügt haben, die jedoch weiterhin funktionieren. Sie
können den Code mit einem XML-fähigen Editor wie Visual Studio Code 7 oder Brackets 8 bear-

7. https://code.visualstudio.com/
8. https://brackets.io/

SVG
https://code.visualstudio.com/
https://brackets.io/
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beiten. Das ist einfacher als den XML-Editor in Inkscape zu verwenden. Untersuchen Sie den
SVG-Quellcode des zweiten Apfels rechts. Sie werden dort zusätzliche XML-Attribute sehen.

Figure 1 Figure 2
SVG clipart : https://arbores.tech/e/e/food_drink/food-f
ruit/green-apple-twemoji.clipart.svg, anschließend Strg+U
für den Code

Stickbares SVG : https://arbores.tech/e/e/food_drink/food
-fruit/green-apple-twemoji-inkstitch.svg

Warnhinweise
— Digitalisieren Sie keine komplexen SVG-Zeichnungen mit vielen Details.
— Digitalisieren Sie keine Logos, bevor Sie einige einfachere Objekte erstellt haben.
— Versuchen Sie nicht, einmit einer Kamera aufgenommenes Foto zu digitalisieren (einfache hand-

gezeichnete Motive oder saubere Logos lassen sich dagegen relativ leicht vektorisieren und digi-
talisieren). Empfohlene Strategie für zu komplexe Rasterbilder : Bild als Hintergrund verwenden
und die Objekte neu zeichnen.

— Digitalisieren Sie keine Schriftarten manuell – die Ergebnisse sind für Maschinenstickerei un-
geeignet. Verwenden Sie stattdessen das Schriftmodul von Ink/Stitch, das bereits digitalisierte
Schriften nutzt. Sobald Sie jedoch Satinsäulen gut beherrschen, können Sie eigene Schriften ers-
tellen.

— ImportierteSVG-Dateienmüssenüberprüft undbereinigtwerden (insbesonderePolygone schließen,
Linien glätten undObjekte auftrennen, die ausmehreren Polygonen bestehen). Siehe unsereHin-
weise zu den wichtigen Inkscape-Erweiterungen 9 für Reinigungsarbeiten.

1.4 Konfiguration von Inkscape und Ink/Stitch
Eine gute Einrichtung der Arbeitsumgebung ermöglicht effizienteres Arbeiten. Eine sorgfältige Ein-
richtung lohnt sich und spart langfristig viel Zeit.
Lesen Sie Ink/Stitch personalisieren10 im offiziellen Handbuch.
Wichtigste Einstellungen (die beiden Dateien befinden sich im starterpack/config-Ordner) :

1. Benutzer-Tastenkürzel :
— Öffnen Sie den Ordner keys über Bearbeiten → Einstellungen → System und kopieren

Sie die Datei default.xml aus dem Starterpack, Ordner config.
2. Garndateien installieren :

— Erweiterungen → Ink/Stitch → Addons für Ink/Stitch installieren. Alles anklicken
und Anwenden.

3. Mini-Gunold-Palette :
9. https://edutechwiki.unige.ch/fr/InkStitch_-_installation#R%C3%A9paration_de_noeuds_et_segments_dupli

qu%C3%A9s_avec_les_outils_MightyScape
10. https://inkstitch.org/de/docs/customize/

https://arbores.tech/e/e/food_drink/food-fruit/green-apple-twemoji.clipart.svg
https://arbores.tech/e/e/food_drink/food-fruit/green-apple-twemoji.clipart.svg
https://arbores.tech/e/e/food_drink/food-fruit/green-apple-twemoji-inkstitch.svg
https://arbores.tech/e/e/food_drink/food-fruit/green-apple-twemoji-inkstitch.svg
https://edutechwiki.unige.ch/fr/InkStitch_-_installation#R%C3%A9paration_de_noeuds_et_segments_dupliqu%C3%A9s_avec_les_outils_MightyScape
https://edutechwiki.unige.ch/fr/InkStitch_-_installation#R%C3%A9paration_de_noeuds_et_segments_dupliqu%C3%A9s_avec_les_outils_MightyScape
https://inkstitch.org/de/docs/customize/
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— Erweiterungen → Ink/Stitch → Verwaltung der Garnfarben → Benutzerdefinierte
Palette installieren und anschließend die Datei *.gpl im selben Ordner config auswäh-
len.

4. Pfadkonturen und Richtungen :
— Bearbeiten → Einstellungen → Werkzeuge → Knotenwerkzeug. Dann Umriss zeigen

und Zeige die Pfadrichtung an Außenlinie anklicken.

2 Aktivität :DigitalisierungeineseinfachenEmojismitTatami-Füllung
Diese Aktivität hat folgende Ziele :

— Eine SVG-Zeichnung so vorbereiten, dass ihre Objekte für die Stickerei parametrisiert werden
können

— Füllungen mit einem Tatami-Stich erzeugen

Die Tatami-Füllung ist eine der fünf Grundformen der Maschinenstickerei und Sie wird dazu verwen-
det grössere Flächenmit einem strukturierten ”Teppich” zu bedecken. Die anderen Grundstiche sind :
Geradestich, Satin/Zickzack, programmierter Stich und manueller Stich.

2.1 Ein Emoji als SVG auswählen und herunterladen
Live-Demo : Eine einfache Zeichnung anpassen und/oder verwenden

Öffnen Sie in Inkscape eine Clipart-Datei aus dem Ordner clipart des Starter-Packs. (alternativ von
https://arbores.tech/e/inkstitch/starter-pack/clipart/)

Figure 3 – Auswahl von Clipart-Dateien

2.2 Anpassung der Größe einer SVG-Zeichnung
Nachdem Sie die Zeichnung in Inkscape geöffnet haben,müssen Sie zunächst die Größe der Zeich-
nung sowiedieGrößedesDokuments anpassen.Dies erfolgt indreiHauptschritten (insgesamt8Schritte).
Überlegen Sie zuerst, welche Größe Ihre Stickerei haben soll, und berücksichtigen Sie dabei die Größe
Ihrer Stickrahmen. Diese Einstellungen können zwar später geändert werden, aber da die Stickerei
materiellen Einschränkungen unterliegt (Rahmengröße, Garnstärken, physische Bewegung der Nadel
(1/10 mm), Dehnungseffekte usw.), ist es besser, von Anfang an im richtigenMaßstab zu arbeiten.
Für diesen Kurs sollte die Breite oder Höhe 48 mm nicht überschreiten.
Schritte zur Anpassung der Größe einer Zeichnung (siehe auch die Bildschirmkopien unten)
A. Schritte 1–3 : Maßeinheiten anpassen

— Datei → Dokumenteneinstellungen... :
1. Anzeigeeinheiten = mm
2. Benutzerdefiniert = mm
3. Skalierung = 1

— Englisch : File → Document Properties : Display units = mm, Custom size = mm, Scale x = 1

B. Schritte 4–5 : Größe der Zeichnung anpassen
— Strg+A, anschließend die Proportionen in der Menüleiste sperren und auch dort einen Wert für

die Höhe oder Breite eintippen. Nicht mit der Maus vergrößern!
— Die Größe auf maximal 48 mm einstellen

C. Schritte 6–8 : Größe des SVG Dokuments anpassen
— SiekännendieDokumentgrößeentsprechendderGröße IhresStickrahmens festlegen, z. B. 50×50

mm für einen rechteckigen 5×5-cm-Rahmen.
— Alternativkönnen : Strg+A,dannDatei → Dokumenteneigenschaften → Seite an Inhalt anpassen

https://arbores.tech/e/inkstitch/starter-pack/clipart/
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— Wenn Sie weitere Elemente hinzufügen oder die Größe ändern, müssen Sie Schritt „C” wiederho-
len. Das Stickmotiv sollte ca. 2 mm kleiner sein als der Rahmen, den Sie verwenden möchten, da
der Dehnungsausgleich (pull compensation) die Elemente leicht vergrößern kann (siehe zB die
verfügbaren Rahmen der Brother PR1050X).

Figure 4 – Größe eines Dokuments in Inkscape 1.2 anpassen

Kontrolle : Alle Elemente (mit Strg+A ausgewählt) müssen sich innerhalb des Rechtecks befinden,
das die Größe des Dokuments darstellt. So stellen Sie sicher, dass die Stickerei in den Rahmen passt.
Eine Stickdatei kann nicht wesentlich verkleinert oder vergrößert werden, ohne bestimmte Designe-
lemente neu zu überdenken und die Stiche neu zu generieren.

2.3 Parameter der Tatami Füllung
— Handbuch : Füllstich 11 (bitte zunächst überfliegen, später gründlich lesen!)

Jede zu füllende Fläche muss ein Polygon in Form eines SVG-Pfads ohne Kontur sein.

— Um eine Füllung zu erzeugen, muss die Kontur entfernt werden, sodass nur die Fläche übrig
bleibt. Falls nötig :

Menü Objekt → Füllung und Kontur → Reiter Konturfarbe „Keine Farbe” auswählen oder al-
ternativ Umschalt+Klick unten links im Arbeitsbereich
Englisch : Object → Fill and Stroke → Stroke Paint „No paint” auswählen

UmeinStickobjekt zuparametrisieren, öffnenSiedasParameterfenster :Erweiterungen → Ink/Stitch
→ Parameter (Strg+Umschalt+P). Siehe Abbildung unten.
Mehrere Parameter sind wichtig :

1. Die Füllmethode : automatische Füllung (Tatami) beibehalten
2. Den Füllwinkel einstellen (gegen den Uhrzeigersinn) : Winkel der Stichlinien (engl. Angle of

lines of stitches).
3. Lücken zwischen Abschnitten schließen : Lücken schliessen verwenden, wenn eine größere

Fläche gefüllt wird und die Simulation zeigt, dass sie von mehreren Seiten aus gestickt wird. Da-
durch lassen sich weiße Linien vermeiden, die durch Verzerrungen entstehen können.

4. Länge des Füllstichs : Maximale Stichlänge (engl.Maximum fill stitch length)
5. DieDichte zwischendenReihen : Reihenabstand (engl. Spacing between rows). Empfohlen sind

Werte zwischen 0,2 (5 Reihen/mm) und 0,25 (4,5 Reihen/mm).
6. Standardmäßig erzeugt Ink/Stitch 4 versetzte Reihen. EineÄnderungdes Stichversatzes verän-

dert das visuelle Ergebnis deutlich (3 = glatter, 5 = kräftiger).
7. Dehnungsausgleich : Zugkompensation ist sehr wichtig, um zu kompensieren, dass die Stiche

sich in Stichrichtung zusammenziehen. Es wird empfohlen, einen Standardwert vonmindestens
11. https://inkstitch.org/de/docs/stitches/fill-stitch/

https://inkstitch.org/de/docs/stitches/fill-stitch/
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0,3 mm zu setzen oder Tatami-Flächen manuell zu überlappen.

Weitere Einstellungen :

— Wenn Sie eine sehr leichte Stickerei erstellen, entfernen Sie den Unterpfad (Unterpfad)
— Lassen Sie die Parameter für die Unterlage (zweiter Reiter) unverändert, außer bei sehr leichter

Stickerei – dann kann sie entfernt werden
— Konsultieren Sie auch das Handbuch12 !

Figure 5 – Einstellung einer Tatami-Füllung in Ink/Stitch 3.2x

Mehrere Objekte können gleichzeitig ausgewählt werden, oder auch eine ganze Gruppe bzw. Ebene.
Wir empfehlen jedoch, die Objekte am Schluss des Arbeitsprozesses einzeln zu parametrisieren, damit
man beispielsweise die Stichrichtung variieren kann.
Die Funktionen von Ink/Stitch werden ständig weiterentwickelt. Die Benutzeroberfläche kann sich
ändern, aber die Prinzipien bleiben gleich.

2.4 Sortierung der Objekte
Die Reihenfolge der zu stickenden Objektemuss festgelegt werden, bevor man mit Objekttransfor-
mationen beginnt.

1. Das Objektfenster öffnen (Menü Objekt → Ebenen und Objekte)
2. Die Objekte am unteren Ende des Stapels werden zuerst gestickt. Die Verwendung von Gruppen

oder Ebenen (eine Ebene ist im SVG ebenfalls eine Gruppe) hat keinen Einfluss : Wenn Ink/Stitch
auf eine Gruppe trifft, stickt es zuerst das unterste Element der Gruppe. Für einfache Zeichnun-
gen wird daher von der Verwendung von Ebenen und Gruppen abgeraten.

3. Objekte können nach oben oder unten verschoben werden (Drag-and-Drop mit der Maus oder
mit den Pfeilen)

2.5 Simulation
Qualität des Motivs prüfen
Sobald Sie mit den Parametern zufrieden sind, können Sie die Stiche, die Stickreihenfolge, Sprung-
stiche usw. anzeigen lassen. Mit dem Schieberegler kann man im Detail den Stickverlauf überprü-
fen.

— Das oder die Objekte auswählen oder alles abwählen, um das gesamte Motiv zu sehen
— Erweiterungen → Ink/Stitch → Visualisieren & Exportieren → Simulator (Strg+Umschalt+L)

ÜberprüfenSie :Stickreihenfolge, fehlendestarkeÜberlappungen,allgemeinesErscheinungsbild
Wenn die Simulation nicht startet, liegt wahrscheinlich ein Fehler in einem Objekt vor. Schließen Sie
das Fenster und lesen Sie die Fehlermeldung.
12. https://inkstitch.org/de/docs/stitches/fill-stitch/

https://inkstitch.org/de/docs/stitches/fill-stitch/
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— Wenn der Pfad kein Polygon ist, muss er geglättet oder manchmal getrennt werden. Alternativ
kann eine „Knotenoperation” erforderlich sein.

— Wenn das Objekt kein Pfad ist, sollte es in einen Pfad umgewandelt werden. Das gilt vor allem
für Inkscape-Schriften (nur sehr große Buchstaben benötigen dies).

Visuelle Darstellung prüfen
Um eine „realistische” Simulation zu erhalten, muss ein Stickplan erzeugt werden :

— Erweiterungen → Ink/Stitch → Visualisieren & Exportieren → Stickplan-Vorschau,Me-
thode „Realistisch” (normalerComputer) oder „Realistisch, hoheQualität” (leistungsstarkerCom-
puter)

2.6 Die Maschinendatei erzeugen und an die Stickmaschine übertragen
— Die Stickdatei exportieren : Datei → Kopie speichern (Englisch : File → Save a copy)
— Das passende Dateiformat für Ihre Maschine auswählen (*.pes oder *.dst für Brother-Maschinen)
— Die Datei an einem gewünschten Ort auf Ihrem Computer speichern
— Die Datei auf einen USB-Stick übertragen
— Achtung : Verwenden Sie nicht Datei → Speichern unter, da sonst Ihre SVG-Quelldatei verlo-

ren geht !

3 Verwendung der Maschine
Jeder Hersteller verwendet ein proprietäres Format. Viele Heimstickmaschinen erkennen auch DST,
einen einfachen Industriestandard.

Format Kompatible Maschine Anmerkungen

DSB Barudan (Tajima) Industrielles Format, das Farben speichert. Wird von mehreren neueren Maschinen erkannt.
DST Tajima und andere Industrielles Standardformat, minimalistisch (ohne Farben), sehr weit verbreitet.
PES / PEC Brother, Baby Lock Gängiges Format von Brother. PEC entspricht nur dem Maschinencode.
EXP Melco, Bernina Format für Bernina und industrielles Format für Melco.
JEF Janome Format für Janome- und Elna-Maschinen.
VP3 / VIP Husqvarna, Pfaff VIP ist eine ältere Version von VP3.
XXX Singer Spezifisches Singer-Format.
GCODE DIY Wird von selbstgebauten Maschinen auf Arduino-Basis oder ähnlichen Systemen verwendet.

3.1 Garnstärken und Nadeln
Standardmäßig verwendet die Haushaltsstickerei Garne der Stärke 40 und Sticknadeln der Größe 75.
Die Garnstärke ist dabei als Garnlänge pro Kilogramm definiert : Ein Kilogramm Garn der Stärke 40
lässt sich auf bis zu 40 kmabrollen,währendmanmit dem sehr dünnenGarn der Stärke 75 fast doppelt
so weit kommt. Mit dem dicken Garn der Stärke 12 hingegen erreicht man nur etwa 12 km. Einsteiger
sollten mit Polyestergarn der Stärke 40 arbeiten.
Mit Garn der Stärke 60 und einer feineren Nadel kannman kleine Satinstiche ausführen, insbesondere
kleine Schriften.MitGarnder Stärke 75 lassen sichnoch feinereDetails sticken, zumBeispiel Schriften
von nur 3 mm Höhe.
Garnstärken 30 und 12 werden für rustikalere Motive verwendet. Diese Garne bestehen meist aus Na-
turfasern wie Baumwolle, Wolle oder Viskose, es gibt jedoch auch Acrylmischungen. Für dickes Garn
benötigt man dickere Topstitch-Nadeln mit langer Öse.

3.2 Vor dem Start
Bevor Sie die Maschine starten, sollten folgende Punkte überprüft werden :

— Rahmen : Den passenden Stickrahmen für Ihr Motiv auswählen (Motiv muss vollständig in den
Rahmen passen) und das Gewebe gleichmäßig und straff einspannen – weder zu locker noch zu
stark gespannt.

— Stabilisator :Einengeeigneten Stabilisator unter dasGewebe legen. Für Anfänger empfiehlt sich
ein Abreißstabilisator auf einem stabilen Stoff und ein Schneidstabilisator auf einem dehnbaren
Stoff. Filmoplast (ein klebender Stabilisator) eignet sich für die meisten Zwecke, ist aber teuer
und verschmutzt die Nadeln.

— Nadel : Die richtige Nadel montieren. Für Standardstickerei : Größe 75 mit Sticköse (75/11 H-E)
mit Garn der Stärke 40. Bei feinen Schriften oder Satinstichen : Größe 65–70 mit Garn der Stärke
60.

— Faden : Oberfaden und Spule (Unterfaden) korrekt einfädeln. Die Fadenspannung prüfen.
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— Dateiübertragung : Die Stickdatei auf einen USB-Stick kopieren und in die Maschine einlesen.
Auf demMaschinenbildschirm Größe und Position des Motivs vor dem Start kontrollieren.

— Probestich : Immer zuerst einen Probestich auf einem ähnlichen Gewebestück ausführen, be-
vor das eigentliche Werkstück bestickt wird. So lassen sich Fadenspannung, Dichte und Farben
vorab prüfen.

3.3 Während der Stickerei
— Die Maschine nicht unbeaufsichtigt laufen lassen, besonders bei längeren Motiven.
— Die Fadenspannung regelmäßig beobachten – sowohl Ober- als auch Unterfaden. Eine falsche

Spannung zeigt sich durch Schlaufen auf der Vorder- oder Rückseite.
— Bei einem Fadenriss die Maschine anhalten, den Faden neu einfädeln und einige Stiche vor der

Unterbrechungsstelle wieder aufsetzen, damit keine Lücke entsteht.
— Bei einem Maschinenstopp (Fehlermeldung) die Ursache lesen und beheben, bevor Sie fortfah-

ren.

3.4 Nach der Stickerei
— Sprungstiche (Verbindungsstiche) auf Vorder- und Rückseite mit einer Stickschere abschnei-

den.
— DenStabilisator entfernen : Schneidstabilisator abschneiden,Reißstabilisator vorsichtig abreißen,

wasserlöslichen Stabilisator auswaschen.
— Das fertige Stück ggf. bügeln : von der Rückseite auf einem weichen Tuch, um die Stiche nicht

zu beschädigen. Nicht alle Gewebe vertragen Hitze – vorher prüfen.

3.5 Tipps für Anfänger
— Beginnen Sie mit einfachen, kompaktenMotiven (z. B. Emojis aus dem Starter-Pack) auf einem

stabilen, nicht dehnbaren Gewebe wie Baumwoll-Canvas.
— Verwenden Sie für erste VersucheKontrastfarben zwischen Faden und Stoff – so sehen Sie Feh-

ler sofort.
— KleineMotive (unter 50mm) sind einfacher zu handhaben als große, daweniger Fadenfarbenund

Rahmeneinspannungen nötig sind.
— Speichern Sie Ihre Ink/Stitch-Dateien regelmäßig und bewahren Sie die SVG-Originaldatei auf –

nur so können Sie Änderungen vornehmen. Eine exportierte Maschinendatei (*.pes, *.dst usw.)
kann nicht zurück in ein bearbeitbares Format umgewandelt werden.

4 Aktivität : Manipulationen in Inkscape
Wir werden anhand eines Beispiels einige Inkscape-Manipulationen zeigen.
Fortgeschrittene Teilnehmer können auch eine andere einfache SVG-Zeichnung suchen. Es wird emp-
fohlen, mit Emojis aus der Schriftart „Twitter” zu arbeiten. Das Emoji muss einfach sein, zum Beispiel :
Emoticons, Hände, Obst und Gemüse. Keine PNG/JPG-Dateien, keine komplexen SVG-Zeichnungen.

1. Wenige Elemente
2. Keine kleinen Details (sonst sollten Sie sie entfernen)
3. Wenige Linien (siehe Punkt 1)

SVG-Zeichnungen für Twitter-Emoji-Schriften findet man auf mehrerenWebsites. Wir empfehlen, sie
bei iconify.design13 zu beziehen.

4.1 Umgangmit zusammengesetzten Objekten und Überlagerungen
(1) Ink/Stitch verlangt, dass geweisse Füllungenmit einem einzigen Objekt erstellt wird, das die Form
eines geschlossenen Polygons haben muss. Falls nötig, müssen Objekte daher getrennt werden, was
auf jeden schon mal erlaubt Stickwinkel anzupassen.
(2) Grafiker arbeiten fast immer mit überlagerten Ebenen. Daher müssen alle importierten Zeich-
nungen überprüft und diese Überlagerungen entfernt werden! Es ist möglich, ein kleines Objekt
(z. B. einen Mund oder ein Auge) über eine bereits gestickte Fläche (z. B. ein Gesicht) zu sticken. Man
sollte jedoch niemals zwei oder mehr dichte Schichten übereinander sticken, da die Stickerei sonst
hart und gespannt wird. Ab etwa vier Schichten kann die Nadel brechen (oder Schlimmeres). Eine Ma-
schinenreparatur kann mehrere hundert Euro kosten …

Live-Demo : Augen in Herzform

13. https://icon-sets.iconify.design/twemoji/?category=Emoji

https://icon-sets.iconify.design/twemoji/?category=Emoji
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Figure 6 – smiling face with ...

Zusammengesetzte Polygone trennen
Manchmal befinden sichmehrere Polygone in einem einzigen Pfad und lassen sich leicht trennen, zum
Beispiel zwei Augen oder zwei Augenbrauen.

— Objekt auswählen, dann Strg+Umschalt+K oder Menü Pfad → Zerlegen
— Englisch : Path → Break Apart

Figure 7 – Objekte trennen, die einen Pfad bilden

Falls nötig, müssen die Farben repariert werden (Objekt → Füllung und Kontur, engl. Object →
Fill and Stroke) oder besser die Palette am unteren Rand des Bildschirms verwenden.
Überlagerungenmit dem Operator „Vereinfachen/Auflösen” verwalten

— Pfad → Auf Sichtbares reduzieren – entfernt alle Überlagerungen
— Achtung : Funktioniert nur, wenn die Objekte korrekt gezeichnet sind (geschlossene Poly-

gone, keine überlagerten Knoten). Daher müssen Objekte überprüft und gegebenenfalls repa-
riertwerden,wenn das Ergebnis nicht korrekt ist. Denken Sie daran, die empfohlenenReparatur-
Erweiterungen aus Réparation de nœuds et segments dupliqués avec les outils MightyScape zu
installieren.

Überlagerungenmit dem Operator „Differenz” verwalten
BearbeitenSiedieObjekte imObjektfenster vonuntennachoben (Positionhinten→vorne) und führen
Sie Subtraktionen wie im folgenden Beispiel aus (Operator „Differenz” Strg+-).
Beispiel : Wir wollen vermeiden, dass die großen Herzen dieses Emojis über das Gesicht gestickt wer-
den.
Um ein Objekt „Herz” von einem Objekt „Gesicht” zu subtrahieren :

1. Herz duplizieren : Strg+D (oder Kontextmenü → Duplizieren)
— Das subtrahierte Objekt wird gelöscht, daher muss es vorher dupliziert werden. Das höhere

Objekt im Stapel wird subtrahiert, nicht das zuletzt ausgewählte ! Ein dupliziertes Objekt
wird immer oben eingefügt, daher gibt es kein Problem.

2. Größe des duplizierten Objekts verkleinern (es befindet sich oben im Objektstapel) :
— Deutsch : Pfad → Schrumpfen oder Strg+(
— Englisch : Path → Inset

3. Gesicht und dupliziertes Herz auswählen : Umschalt+Klick Das Objekt weiter oben im Stapel
(mehr im Vordergrund) wird abgezogen.
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4. Pfad → Differenz (engl. Path → Difference) oder Strg+-
5. Farbe bei Bedarf korrigieren

Weitere Werkzeuge in Inkscape 1.3+ zur Verwaltung von Überlagerungen
— Pfad → Division : erlaubt es, ein Objekt mit einer Linie zu trennen (eine Art Schere)
— Mehrere Operationen zum Vereinigen, Subtrahieren oder Schneiden sind mit dem Formeners-

tellungswerkzeug (engl. Shape Builder) möglich (3. Symbol in der Werkzeugleiste links). In der
Praxis ist es jedoch oft einfacher, die einfachen Pfadoperationen zu verwenden.

Objekte bei Bedarf in Pfade umwandeln
Ink/Stitch arbeitet vorzugsweise mit Objekten vom Typ „Pfad”. Wenn Ihre Zeichnung „Primitive” en-
thält, wie einen Kreis (circle), ein Rechteck (rect) oder auch Text, müssen diese manchmal in Pfade
umgewandelt werden :

— Deutsch : Pfad → Objekt in Pfad umwandeln
— Englisch : Path → Object to Path

Im Zweifel : Alles auswählen (Strg+A) und in Pfade umwandeln.
Zwischen Füllung und Kontur wählen
Ein Objekt sollte entweder eine Kontur oder eine Füllung haben, um ein gutes Ergebnis zu erzielen.
Genauer gesagt :

— Eine Linie sollte eine Kontur sein (und kein langes, dünnes Polygon)
— Ein zu füllendes Polygon muss eine Füllung haben, aber keine Kontur
— Ein Polygon, das als „Line Art” gestickt wird, sollte eine Kontur haben, aber keine Füllung

UmFüllungundKontur zu setzen, verwendetmanambestendie Steuerelementeder Farbpalette (Klick
auf eine Farbe für die Füllung, Strg+Klick für die Kontur).
Achtung : Manche Zeichnungen enthalten schlecht geschlossene Polygone. Um sie zu schließen, kann
man sie glätten (Strg+L), Erweitern/Schrumpfen, ein Reparaturwerkzeug verwenden oder das feh-
lende Segment manuell identifizieren und schließen.

4.2 Knoten-Chirurgie
OftmussmanPfademit demKnotenbearbeitungswerkzeugbearbeiten,washiernicht imDetail erklärt
wird. Es wird dringend empfohlen, mit einem Tutorial zu üben.
Prinzipien

Figure 8 – Inkscape : Werkzeuge für Pfade und Knoten

Beispiel Noun Project
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— Die Icons des Noun Project 14 eignen sich im Allgemeinen gut für Stickerei, benötigen jedoch oft
etwas Vorbereitungszeit.

— Sie werden häufig als ein einziger Pfad geliefert, der zuerst zerlegt werden muss (engl. Break
apart) : Pfad → Zerlegen (Strg+Umschalt+K), um anschließend Objekt für Objekt zu bearbei-
ten.

— Wenn Linien tatsächlich Füllungen sind, kann man Pfad → Kontur in Pfad umwandeln (engl.
Stroke to Path) verwenden, um sie in Linien umzuwandeln.

5 Beschriftung
Im Allgemeinen ist es besser, bereits digitalisierte Schriftarten zu verwenden, da die Digitalisierung
einzelner Buchstaben schwierig und zeitaufwendig ist.

— Offizielles Handbuch 15 (unbedingt lesen!)

5.1 Eine Beschriftung erstellen
— Erweiterungen → Ink/Stitch → Text → Text Werkzeug (engl. Lettering Tool)
— Eine kleine Schriftart auswählen, abhängig von der Anzahl der Buchstaben, und den Text einfü-

gen. Nurwenige Schriftarten eignen sich für ein kleines Abzeichen! Einige, wie Glacial Tiny, sind
bereits für Garn der Stärke 60 digitalisiert undmüssenmit einer Nadel der Größe 60 gestickt wer-
den. Im Kurs, bitte eine Schrift verwenden die mit 40er Garn gestickt werden kann.

— DieGröße imBeschriftungswerkzeug einstellen (Sie können später zurückgehen,wenndieGröße
nicht passt)

— Auf Anwenden und Schliessen (engl. Apply and Quit) klicken

Hier ein Screenshot aus Ink/Stitch 3.1, der die wichtigsten Schritte für den Einstieg in das Beschrif-
tungswerkzeug zeigt :

1. Die Filter nutzen. Hier wird „Kleine Schriftgrösse” ausgewählt
2. Die Schriftart auswählen und die Beschreibung sorgfältig lesen (insbesondere den Hinweis zur

Verwendung einer Nadel der Größe 60)
3. Den Maßstab der Schrift festlegen (hier ist er auf 80 % gesetzt)
4. Die Ausrichtung festlegen
5. Eventuell Abstände und Zeilenhöhe definieren. Wir setzen den Zeichenabstand etwas höher.
6. Den Text eingeben
7. Entscheiden, ob und gegebenenfalls wo der Faden abgeschnitten werden soll (zu viele Schnitte

ziehen am Stoff). Wir schneiden nur nach jedemWort.

Warnung :DigitalisierteSchriftarten sind für einebestimmteGrößeoptimiert. SkalierenSie eineSchrift
daher nicht mit einer Inkscape-Transformation. Im besten Fall erhalten Sie ein zweifelhaftes Erschei-
nungsbild, im schlimmstenFall entstehenKnoten oder Fadenbrüche. (Mit Garnder Stärke 60und einer
Nadel der Größe 60 kann man die Größe etwa um weitere 40 % reduzieren.)
Eine bestehende Beschriftung lässt sich leicht ändern :

— Beschriftung auswählen
— Das Text-Werkzeug öffnen : Strg+Umschalt+Q

5.2 Der Ink/Stitch-Schriftkatalog
— Die offizielle Schriftbibliothek 16 bietet einen Überblick über alle verfügbaren Schriftarten
— Jede Schrift ist detailliert beschrieben (Glyphen, Größen, gestickte Beispiele). Klicken Sie da-

rauf !

5.3 Ausrichtung entlang einer Kurve
— Eine Linie zeichnen. Um entlang eines runden Abzeichens zu sticken, zeichnen Sie einen Kreis

und behalten Sie anschließend ein Segment.
— Die Beschriftung und die Linie auswählen
— Erweiterungen → Ink/Stitch → Text → Text entlang Pfad
— Falls nötig Strg+Z und erneut versuchen
— Danach muss diese Linie verborgen werden, damit sie nicht gestickt wird (alternativ kann man

eine Anweisung hinzufügen, die das Objekt als nicht stickbar markiert)

14. https://thenounproject.com/
15. https://inkstitch.org/de/docs/lettering/
16. https://inkstitch.org/de/fonts/font-library/

https://thenounproject.com/
https://inkstitch.org/de/docs/lettering/
https://inkstitch.org/de/fonts/font-library/
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Figure 9 – Beschriftungs-Popup in Ink/Stitch 3.3

Tipps :
— Für eine Platzierung innerhalb einer gebogenen Linie : eine Linie zeichnen, die etwa 20 % län-

ger als die Beschriftung ist, und „Ausdehnen” (engl. extend) aktivieren. Alternativ kann man die
Buchstaben in dem Text Werkzeug mehr auseinander setzen.

— Keine zu engen Kurven verwenden
— Die Richtung der Linie beeinflusst die Platzierung, z. B. von links nach rechts, um den Text inne-

rhalb der Kurve zu platzieren. Die Richtung eines Pfads kannmit Pfad → Umkehren oder Strg+R
geändert werden

— Vergessen Sie nicht, die Linie zu verstecken oder als nicht stickbar zu markieren : (Befehle →
Objektbefehle hinzugügen → Ignoriere dieses Objekt (nicht nähen)

— Einzelne Buchstaben können bei Bedarf manuell neu positioniert werden

6 Aktivität : Digitalisierung von Linien
Ziele :

— Linien mit einfachem, wiederholtem oder dreifachem Geradstich digitalisieren

Live-Demo , Hinzufügen von Linien zu einem bereits verwendeten Objekt

6.1 Inkscape-Zeichnungenmit Linien
Erstellen Sie Objekte mit Linien. Sie haben mehrere Möglichkeiten :

— Line-Art-SVG importieren (kann kompliziert werden, daher eher vermeiden)
— Mit demWerkzeug „Freihand” (Bleistift) oder dem Bézier-Werkzeug zeichnen
— Einem Polygon eine Kontur hinzufügen und die Füllung entfernen
— Ein primitives Objekt erstellen, die Kontur behalten und es anschließend in einen Pfad umwan-

deln

Linienbreite :

— Ink/Stitch ist es egal, wie breit eine Linie ist oder ob sie gestrichelt ist. Das Ergebnis ist immer
dasselbe (außer für die Füllung mit Satinstich, eine Neuheit in Ink/Stitch 3.3, Juni 2026).

— Wir empfehlen jedoch, mit 0,2 mm für einfache Geradstiche und 0,3 bis 0,4 mm für Mehrfachs-
tiche zu arbeiten. So erhält man einen Anhaltspunkt für die Stichdeckung.

Tipps zum Freihandzeichnen :

— In der Menüleiste oben : Glättung auf etwa 50 setzen (sonst später mit Strg+L glätten)
— Die Füllung auf „keine Füllung” setzen und der Kontur eine Farbe Ihrer Wahl geben (dies kann

auch nach dem Zeichnen der Linie erfolgen)
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Transformationen zur Vorbereitung der Digitalisierung
— DasObjektmuss einPfad sein (diesbetrifft insbesondereKonturenprimitiverPolygonewieKreise !)
— Es ist besser, eine Liniemit Anfang und Ende zu definieren, aber Ink/Stitch verarbeitet auch Kon-

turen von Polygonpfaden ohne klar sichtbaren Anfang oder Ende.

6.2 Ink/Stitch-Parameter
Ein einfacher Geradstich wird nur selten verwendet. Daher sollte man eine Linie entweder zweimal
wiederholen oder einen Dreifachstich verwenden. Die wichtigsten Parameter sind :

— Anzahl der Wiederholungen der Linie :
— Wiederholungen : normalerweise 1–3

— Anzahl der Wiederholungen der Stiche :
— Mehrfachgeradstich Wiederholungen = 1 ergibt einen Dreifachstich (vorwärts → zurück

→ vorwärts). Standardmäßig steht die Wiederholungszahl auf 0 (keine Wiederholung).
— Mehrfachgeradstich Wiederholungen = 2 ergibt einen fünffachen Stich.

— Geradstichlänge :
— Stichlänge kann auf dem Standardwert belassen werden.

Kombinationen aus vielen Wiederholungen und Dreifachstichen sollten vermieden werden, da sonst
zu viele Einstiche an derselben Stelle entstehen und dadurch Knoten oder Stoffbeschädigungen auf-
treten können. Man kann jedoch eine Wiederholung eines Dreifachstichs verwenden.

Figure 10 – Beispiel Apfel, Parameter für Geradstich in Ink/Stitch v 3.3

Tipp : Verwenden Sie wiederholte Linien oder nebeneinanderliegende Dreifachstiche mit einem Abs-
tand von etwa 0,4 mm, um „dicke Linien” von etwa 0,5 bis 1,5 mm zu sticken. Unterhalb von etwa 1,5
mm ergibt ein Satinstich meist kein gutes Ergebnis.

7 Die Stiche von Ink/Stitch 3.3
Hier ist eine gestickte Übersicht der Stiche von Ink/Stitch 3.3 (Juni 2026)

7.1 Wiederholung einiger Prinzipien
Verwendung von Ink/Stitch (siehe auch oben)

— Es ist unbedingt erforderlich, die Anzeige der Konturen und der Konturrichtung zu konfigurieren
— Es wird außerdem empfohlen, Tastenkürzel und eine Palette zu installieren (siehe Starter-Pack)

Starter-Pack
— Enthält „default.xml”, eine kleine Gunold-Palette, Abzeichen-Motive und einige Emojis.
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Figure 11 – Die Füllstiche von Ink/Stitch 3.3

— ZIP herunterladen : https://arbores.tech/e/inkstitch/starter-pack/starter-pack.zip
— Entpacken

Die Stickstiche
— Es gibt drei grundlegende Stiche in der Maschinenstickerei : Geradstich, Satinstich und Tatami-

Füllung.
— Geradstichewerden für „Line Art” (Redwork usw.), für Konturen, zum „Zeichnen” über einer Fül-

lung, für programmierte Stiche usw. verwendet.
— Der Satinstich dient dazu, breite Linien (1,5 bis 6 mm) sowie unregelmäßige Kolonnen (z. B. Blät-

ter, Lippen, Schrift usw.) zu erstellen. Mit einem Satinstich lassen sich starke Licht- und Glanzef-
fekte erzeugen.

— Die Tatami-Füllungwird verwendet, um Flächen zu bedecken (geschlossene Polygone).

Es existierenmehrere andereFülltypen.Beispielsweisekannmanstatt einerTatami-FüllungeineKontur-
, Kreis- oder geteilte Satinfüllung verwenden.
Der Dehnungseffekt (engl. pull)

— Es gibt eine Dehnung entlang der Stichrichtung, daher muss dieser Effekt kompensiert werden.
Entweder zieht man das Objekt manuell in Stichrichtung auseinander oder man fügt eine Kom-
pensation in den Parametern hinzu. Bei kleinen Objekten kannman auch alles überlappen lassen
(etwa 0,4 mm).

Zu vermeiden
— Konturen eines Polygons kreuzen (wie in einer „8”) → die Form kann nicht gefüllt werden
— Mehr als 2 Tatami-Schichten übereinander legen → die Stickerei wird hart („Beton”), Nadeln bre-

chen
— Zu schmale Satinstiche erstellen (< 1,5 mm) → zu starke Dehnung, „Betonlinie”, Stoff reißt bei

T-Shirts
— Zu viele Schnitte nebeneinander setzen (Verriegelungsstiche) → Nadeln brechen, unangenehm

zu tragen
— Auf elastischen Stoffen (die meisten) ohne Stabilisator sticken → starke Verformungen

Ink/Stitch-Konventionen
— Um einen Geradstich (einfach, dreifach oder wiederholt) zu erstellen, muss eine Linie ohne Fül-

lung gezeichnet werden.
— Um einen Satinstich zu erstellen, benötigt man einen Pfad mit zwei Schienen (siehe unten).
— Um eine Füllung zu erstellen, zeichnen Sie ein einfaches Polygon (ohne Kontur !).

Reihenfolge

https://arbores.tech/e/inkstitch/starter-pack/starter-pack.zip
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— Das Fenster Objekt → Ebenen und Objekte ermöglicht es, Objekte in der Stickreihenfolge zu
sortieren. Unten im Stapel = Hintergrund = zuerst gestickt.

— Es istmöglich, dieRichtungvonLinienumzukehren (Pfad → Umkehren, engl.Path → Reverse).
Mit diesen Befehlen lassen sich Ein- und Austrittspunkte von Füllungen neu definieren, um die
Fadennutzung zu optimieren.

— DasWerkzeugAuto-route Satin ermöglicht es, dasRouting für eine Serie vonSatinstich-Objekten
zu optimieren. Einige Kolonnen werden für diese Optimierung geschnitten. Siehe Satin-Tools 17

für weitere Informationen.

8 Der Satinstich
Dieses Kursmodul ist hauptsächlich der Erstellung von Satin-Kolonnen gewidmet, d. h. Linien oder
andere schmale Formen, die mit parallelen Stichen gefüllt werden. Solche Pfade können auf verschie-
dene Weise erstellt werden, z. B. durch Zeichnen, durch Inkscape Transformationen oder mit Satin
Werkzeugen.

— Ein erstes Beispiel zeigt, wie Abzeichen erstellt werden und wie man Schriftzüge erstellt. Beide
verwenden Satin-Kolonnen.

— Anschließendbetrachtenwir einige Zeichen- undTransformationstechniken genauer.Wir begin-
nen damit, eine SVG-Linie (also eine dicke Kontur) in Satin-Schienen mit Richtungslinien umzu-
wandeln.

Eine Satin-Kolonne wird definiert durch :

— Einen einzelnen SVG-Pfad,
— der zweiUnterpfade enthält, die in dieselbeRichtungverlaufen. Diesewerden auch alsSchie-

nen bezeichnet (auch „Holme” oder einfach „Linien” genannt).
— Die beiden Schienen müssen entweder die gleiche Anzahl von Knoten haben oder durch Rich-

tungslinien (engl. rungs, auch „Sprossen” genannt) verbunden sein.
— Die beiden Schienen sollten in dieselbe Richtung verlaufen, da die Software die gegenüberlie-

genden Punkte in der Reihenfolge verbindet, in der sie auf jeder Schiene erscheinen.

Figure 12. Satin-Kolonne mit Richtungslinien. Die beiden Schienen verlaufen in die-
selbe Richtung (rote Pfeile). Empfohlene Methode.

Figure 13. Satin-Kolonne ohne Richtungslinien (gleiche Anzahl von Knoten).
In den meisten Fällen nicht empfohlen.

Wichtig : Um die Richtung einer der beiden Schienen umzukehren, wählen Sie die Liniemit demWerk-
zeug „Knoten”, dann Pfad → Umkehren (engl. Path → Reverse).

Live-Demo Lippen : Emoji Kiss Mark aus der Schrift Noto (Google), modelliert mit 2 Satin-Kolonnen

17. https://inkstitch.org/de/docs/satin-tools/

https://inkstitch.org/de/docs/satin-tools/


9 AKTIVITÄT : ABZEICHEN ERSTELLEN, SCHRIFT UND SATINLINIEN 16

— Die folgenden Lippen bestehen aus zwei Objekten, jedesmit Richtungslinien, die leicht zum Zen-
trum zeigen.

— Zeigen Sie denEffekt einer Richtungsänderung, ändern Sie dieOrientierung einer Richtungslinie.
— Clipart-Datei : https://arbores.tech/e/e/smileys_emotion/emotion/kiss-mark-noto.cl

ipart.svg
— Stickfertige Datei : https://arbores.tech/e/e/smileys_emotion/emotion/kiss-mark-not

o-satin-inkstitch.svg

Figure 14. Stickfertige Datei Figure 15. Simulation

Physikalische Einschränkungen von Satin-Kolonnen
Breite
Breite einer Satin-Kolonne : zwischen 1,5 mm und 6 mm :

— Kleiner als 1,5 mm → Bildung einer „Wurst”, Stoffrisse
— Größer als 6 mm → fragiles Ergebnis. Die meisten Maschinen verweigern Satin-Kolonnen über

12 mm.

Kompensation
— Da Satinstiche stark „ziehen”, sollte man in der Regel etwa 10 % Dehnungskompensation hin-

zufügen (das entspricht 0,2 mm bei einem 2-mm-Satin). Bei Pullovern empfiehlt sich ein Wert
zwischen 0,4 mm und 0,6 mm.

— Durch Hinzufügen von Dehnungskompensation lässt sich auch die Breite einer Satin-Kolonne
verändern, ohne sie neu zu zeichnen.

9 Aktivität : Abzeichen erstellen, Schrift und Satinlinien
Ziele :

— Parameter von Objekten festigen
— Eine bereits parametrisierte Zeichnung mit Satin-Rand wiederverwenden
— Linien in Satinstichen digitalisieren
— Das Beschriftungsmodul verwenden
— Stick-Demo eines Abzeichens (Patch)

Um sich auf die wichtigsten Schritte zu konzentrieren, nehmen wir einige Abkürzungen im Vergleich
zum vollständigen Designprozess :

— indem wir eine bereits für die Stickerei vorbereitete Patch-Vorlage verwenden.
— indemwir bereits fertige Vektorbilder verwenden. Sie können jedoch auch eigene Objekte zeich-

nen, zumBeispiel ein Emoji aus der ersten Sitzungwiederverwenden, sofern ein Element sich für
eine Satin-Kolonne eignet.

Zusammenfassung der Teilaktivitäten :

1. Öffnen Sie eine Patch-Vorlage aus dem Starter-Pack. Der Patch ist stickfertig, ändern Sie nichts
daran.

2. Fügen Sie ein einfaches Vektorbild hinzu, das eine dicke Linie enthält, die in eine Satin-Kolonne
umgewandelt werden könnte.

https://arbores.tech/e/e/smileys_emotion/emotion/kiss-mark-noto.clipart.svg
https://arbores.tech/e/e/smileys_emotion/emotion/kiss-mark-noto.clipart.svg
https://arbores.tech/e/e/smileys_emotion/emotion/kiss-mark-noto-satin-inkstitch.svg
https://arbores.tech/e/e/smileys_emotion/emotion/kiss-mark-noto-satin-inkstitch.svg
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3. Fügen Sie einen kurzen Schriftzug hinzu.

9.1 (1) Patch-Vorlage herunterladen oder öffnen
Live-Demo Verwendung einer Patch-Vorlage

— Es wird empfohlen, entweder einen quadratischen Patch von 6,2 cm oder einen rechteckigen
Patch von 82×62mm zu verwenden. Diese finden Sie im Starter-Pack oder alternativ zum Down-
load in diesemWebordner 18 (Dateien *inkstitch.svg).

— Datei → Öffnen … Datei auswählen.

9.2 (2) Einfaches Bild mit einem Satin-Element einfügen
Wählen Sie ein neues Objekt aus dem Starter-Pack. Alternativ können Sie einMotiv wiederverwenden,
sofern es mindestens eine Satin-Kolonne enthält.

1. ImportierenSie das gewählteVektorbild und zentrierenSie alles vertikal undhorizontal (Objekt
→ Ausrichten und Verteilen, engl.Align&Distribute) ; das gesamteMotivmuss innerhalb der
Patch-Konturen liegen. Mit anderenWorten : Das Bild sollte nicht größer als etwa 4,5 cm sein. Es
wird sogar empfohlen, es etwas kleiner zu machen. So können Sie zusätzlich einen Schriftzug
einfügen.

2. Positionieren Sie das Objekt über den Patch-Objekten, die zuerst gestickt werden sollen.
3. Sie können das Objekt entgruppieren : Objekt → Gruppierung aufheben (Strg+Umschalt+G)

Figure 16 – Auswahl von Clipart-Dateien

9.3 (3) Füllung, Satin-Kolonne und Schrift erstellen
Erstellen Sie ein Stickmotiv mit drei verschiedenen Füllstichen : Tatami-Füllung, Satin-Kolonne und
Schrift. Aus dem Starter-Pack : Kirschen, Mäuse, Olivenzweig, Blumen.
Erinnerung : Tatami-Füllung

— Objekt auswählen
— EinigeObjektemüsseneventuell inPfadeumgewandeltwerden :Pfad → Objekt in Pfad umwandeln

(engl. Path → Object to Path)
— Objekt auswählen und parametrisieren : Erweiterungen → Ink/Stitch → Parameter
— Einstellungen :

— Winkel (Stichrichtung) auf 30 setzen
— Abstand zwischen Linien 0,20 (dicht) bis 0,25
— Eine Unterlage (engl. underlay) hinzufügen, um Verformungen zu reduzieren

— Klicken auf Anwenden und Schliessen

Satin Option 1 : Satin-Kolonne aus einer Linie
— Falls das Objekt kein Linienobjekt ist (sondern ein Polygon), zeichnen Sie eine Linie darüber mit

demMalwerkzeug in der Toolbox links. Stellen Sie die Glättung auf ca. 50 ein.
— Linienbreite zwischen3und5mmeinstellen (2bis 6mm) :Objekt → Füllung und Kontur (engl.

Object → Fill and Stroke → Stroke Style)
— Objekt auswählenundkonvertieren :Erweiterungen → Ink/Stitch → Werkzeuge: Satin →

Linie zu Satin
— Parameter der Satin-Kolonne einstellen : Erweiterungen → Ink/Stitch → Parameter, min-

destens eine Unterlage (engl. underlay) hinzufügen
— Klicken auf Anwenden und Schliessen

Schrift
18. https://arbores.tech/e/e/AA_PATCH_APPLIQUE/

https://arbores.tech/e/e/AA_PATCH_APPLIQUE/
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— Erweiterungen → Ink/Stitch → Text → Text Werkzeug
— Schriftfilter einstellen (oben rechts, falls nötig das Fenster vergrößern)
— Eine kleine Schrift auswählen und Text einfügen
— Größe im Beschriftungswerkzeug einstellen
— Anwenden und Schliessen

Warnung :Digitalisierte Schriften sind für bestimmteGrößenoptimiert. SkalierenSie eineSchrift nicht
mit Inkscape-Transformationen.

9.4 (4) Sticksimulation und Reihenfolge
Um eine Vorschau zu erhalten :

— Objekt(e) auswählen
— Erweiterungen → Ink/Stitch → Visualisieren & Exportieren → SimulatoroderStickplan-Vorschau

Reihenfolge organisieren :

— Objekt → Ebenen und Objekte
— Die Umrandung muss zuerst gestickt werden!
— Objekte per Drag-and-Drop verschieben

9.5 (5) Stickdatei erstellen
— Datei → Kopie speichern (engl. File → Save a Copy)
— Richtiges Maschinenformat wählen (*.pes oder *.dst für die Brother PR1050X)
— Datei speichern
— Auf USB-Stick kopieren

10 Der Knockdown-Stich
Wenn man auf ein T-Shirt oder ein Frotteehandtuch sticken möchte, kann man den Stoff mit einem
Knockdown-Stich stabilisieren — eine Art leichtes Gitter, das die Fasern des Stoffs niederhält. Dieser
Stich ist eine spezielle Konfiguration des Tatami-Stichs (also nichts grundlegend Neues).
Bei Frottee ersetzt der Knockdown-Stich den wasserlöslichen Topper (oder wird zusätzlich zu diesem
verwendet), um die Schlingen des Frotteestoffs zu glätten und ein sauberes Stickergebnis zu erzielen.
Methode :

— Alle Objekte auswählen, die unterstützt werden sollen
— Knockdown-Werkzeug starten :Erweiterungen → Ink/Stitch → Werkzeuge: Füllung → Auswahl

zu Knockdown-Stich (engl. Tools: Fill → Selection to Knockdown Stitch)

Folgende Parameter können kombiniert werden :
Optionen :

— Löcher erhalten : Der Knockdown-Stich füllt Löcher aus oder lässt sie frei.
— Versatz :Wie vielmmsoll derKnockdown-Stich über die ausgewähltenObjekte hinausgehen. Auf

0 oder leicht negativ setzen für einen sogenannten „Custom Underlay”.

Relief-Effekt (Embossing) :

— Entweder ein Rechteck oder einen Kreis generieren, oder eine Form, die der Kontur der aus-
gewählten Objekte folgt. Für diesen zweiten Fall die Form auf „Keine” setzen.

11 Zusätzliche Informationen zum Satin
11.1 Satin in der klassischen Digitalisierung
Ein Satin-Objekt direkt zu digitalisieren ist vor allemdann nützlich, wennman Stickobjektemit einem
Hintergrundbild zeichnet.

— Zeichnen Sie einen Zickzack (es gibt auch andere Möglichkeiten),
— dann Erweiterungen → Ink/Stitch → Werkzeuge: Satin → Zickzacklinie zu Satin

11.2 Satin mit der Knoten-Methode definieren (Beispiel)
Die Methode, bei der ein Satin durch Knotenpaare in zwei gegenüberliegenden Linien definiert wird,
ist die präziseste, aber auch die mühsamste, da sichergestellt werden muss, dass die Anzahl der Kno-
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Figure 17 – Knockdown-Stich, der der Form folgt (ohne Löcher)

Figure 18 – Zickzack zu Satin

ten auf beiden Seiten identisch ist. Das ist nicht immer einfach, insbesondere wenn es sich um einen
komplizierten Pfad handelt oder wenn sich ein Knoten unter einem anderen versteckt.

11.3 Beispiel Rainbow
Live-Demo

Hier ist ein Beispiel, das Sie untersuchen oder verwenden können :
Diese Methode wird empfohlen, wenn Sie ein Motiv später skalieren möchten. Hier ein einfaches Bei-
spiel, basierend auf dem Emoji „Rainbow”. Man kann es beliebig vergrößern oder verkleinern, solange
die Grenzen der Maschine berücksichtigt werden (ein Satinstich sollte mit Garn der Stärke 40 mindes-
tens 1,5 mm breit sein und maximal etwa 1,2 cm – dieser Wert hängt von der Maschine ab und nicht
vom Garngewicht). Für einen stabilen Satinstich empfiehlt sich eine maximale Breite von 6 mm.



11 ZUSÄTZLICHE INFORMATIONEN ZUM SATIN 20

Figure 19 – Emoji Rainbow von Noto/Google, Größe 3 cm

Figure 20 – Regenbogen mit 28 Knoten definiert, leicht zu vergrößern oder zu verkleinern

11.4 Erklärung einer Patch-Umrandung
Live-Demo

Die Satinlinie der Patch-Umrandung, die zu Beginn dieses Moduls gezeigt wurde, vermeidet die Ver-
wendung von Richtungslinien. Sie ist durch etwa 8 Knoten definiert (2 für jede Ecke). Dadurch lässt
sie sich vergrößern oder verkleinern, um den Druck präzise zu kalibrieren. Dieses Beispiel zeigt den
Nutzen dieser Methode. Es ist sehr schwierig, eine Umrandung exakt auszurichten, wenn sie mit Rich-
tungslinien erstellt wurde.

Figure 21. Satin der Umrandung des quadratischen Patches

Download :

— https://arbores.tech/e/e/AA_PATCH_APPLIQUE/

11.5 Satin mit Richtungslinien erstellen
Es gibt mehrere Möglichkeiten, einen Satin zu erstellen, der aus zwei beliebigen Linien besteht :

— Zuerst zeichnen, dann zusammenfügen : Zwei Linien zeichnen, dann die Richtungslinien hin-
zufügen, anschließend alles auswählen (Strg+A) und kombinieren (Strg+K). Keine Vereinigung
(!), jedes Objekt muss ein „Element” innerhalb des Pfades bleiben.

https://arbores.tech/e/e/AA_PATCH_APPLIQUE/


13 ZUSAMMENFASSUNG DES KURSES 21

— Richtungslinien zu einemPfad hinzufügen : DieUmschalt-Taste gedrückt halten, umein Element
zu einem Pfad hinzuzufügen. Ein Element direkt in einen Pfad einzufügen ist eine schnellere Me-
thode.

11.6 Eine Kontur in einen Satin umwandeln
Um Schienen aus der Umrandung eines Objekts zu erstellen, empfehlen sich zwei Methoden.
1) Einfachste Methode :

— Füllung entfernen
— Konturstärke auf mindestens 1,5 mm einstellen
— Linie mit den Satin-Werkzeugen in ein Satin-Objekt umwandeln (siehe oben)

2) Pfad → Kontur in Pfad umwandeln (engl. Stroke to Path), anschließend die Knoten an beiden En-
den aufbrechen.
Beispiel :

1. Eine Ellipse zeichnen
2. Füllung entfernen, Kontur auf > 1,5 mm setzen (2 bis 4 mm sind ideal)
3. Pfad → Kontur in Pfad umwandeln (engl. Stroke to Path)
4. Füllung des neuen Objekts entfernen
5. Konturen auf 0,2 mm Stärke setzen
6. Zwei gegenüberliegende Knoten aufbrechen
7. Richtungslinien hinzufügen (oder die Anzahl der Knoten ausgleichen)
8. Richtung überprüfen : beide Schienen müssen in dieselbe Richtung verlaufen

Hier ist ein Bild mit einer Ausgangszeichnung und dem erwarteten Ergebnis :

12 Freie Übung
Falls noch Zeit bleibt, hier einige Vorschläge :

— Arbeiten Sie an Ihrem eigenen Design weiter
— Nehmen Sie ein SVG-Motiv aus der Ink/Stitch-Bibliothek und verändern Sie es, z. B. durch Hin-

zufügen von Umrandungen. Unsere Emoji-Bibliothek 19 umfasst Hunderte von anpassbaren Da-
teien.

— ZeichnenSie einObjekt vonGrund auf oder importieren Sie eine einfache, d. h.wenig detaillierte
SVG-Datei und passen Sie diese an.

13 Zusammenfassung des Kurses
Dieser 5-stündige Kurs führte in die digitale Maschinenstickerei mit Ink/Stitch (eine Erweiterung für
Inkscape) ein. Die wichtigsten Themen im Überblick :
Grundprinzipien

— Moderne Sticksoftware arbeitet mit Stickobjekten : geometrische Formen, denen ein Stichtyp
und Parameter zugewiesen werden.

— Die drei Grundstiche sind : Geradstich, Satinstich und Tatami-Füllung.
— DerWorkflow umfasst : Zeichnung vorbereiten → Objekte parametrisieren → Reihenfolge festle-

gen → simulieren → Maschinendatei exportieren.

Inkscape-Manipulationen
19. https://arbores.tech/e/e/

https://arbores.tech/e/e/
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— SVG-Objekte für die Stickerei vorbereiten : Überlagerungen entfernen, Polygone trennen, Ob-
jekte in Pfade umwandeln.

— Füllung und Kontur korrekt setzen (Füllung für Tatami, Kontur für Geradstich).
— Pfadoperationen : Differenz, Vereinigung, Kontur in Pfad umwandeln.

Tatami-Füllung
— Geschlossenes Polygon ohne Kontur erforderlich.
— Wichtige Parameter : Füllwinkel, Reihenabstand (0,20–0,25 mm), Zugkompensation (mind. 0,3

mm), Unterlage.

Geradstich
— Linie ohne Füllung. Empfohlen : Dreifachstich (1 Wiederholung) oder wiederholter Stich (2–3×).
— Für „dicke Linien” (0,5–1,5 mm) : nebeneinanderliegende Dreifachstiche mit 0,4 mm Abstand.

Satinstich
— Satin-Kolonne = SVG-Pfad mit zwei Schienen (gleiche Knotenanzahl oder Richtungslinien).
— Breite : 1,5–6 mm. Dehnungskompensation ca. 10 % hinzufügen.
— Erstellung : aus einer Linie (Linie zu Satin), aus einem Zickzack, oder durch Knoten-Methode.

Beschriftung
— BereitsdigitalisierteSchriftenverwenden :Erweiterungen → Ink/Stitch → Text → Text Werkzeug.
— Schriften nicht mit Inkscape-Transformationen skalieren.
— Text entlang einer Kurve : Erweiterungen → Ink/Stitch → Text → Text entlang Pfad.

Diverses
— ImmerDatei → Kopie speichernverwenden,nieSpeichernunter—sonstgehtdieSVG-Quelldatei

verloren.
— Probestich auf ähnlichem Gewebe vor dem eigentlichen Werkstück.
— Für Frottee : Knockdown-Stich als Alternative oder Ergänzung zum wasserlöslichen Topper.

Wichtige Tipps für Einsteiger

Dateiverwaltung — der häufigste Fehler!
— Speichern Sie immer mit Datei → Kopie speichern (nicht Speichern unter) : So bleibt Ihre SVG-

Quelldatei erhalten.
— Bewahren Sie für jedes Projekt eine strukturierte Ablage auf, z. B. :

mein-projekt/mein-projekt.svg ← Arbeitsdatei
mein-projekt/mein-projekt.pes ← Maschinendatei
mein-projekt/original.png ← Referenzbild (falls vorhanden)

— Eine exportierte Maschinendatei (*.pes, *.dst usw.) kann nicht zurück in ein bearbeitbares Format um-
gewandelt werden.

— Arbeiten Sie nie direkt im Starter-Pack-Ordner — die Originaldateien könnten überschrieben werden.
Stickerei

— Immer zuerst einen Probestich auf einem ähnlichen Gewebestück ausführen.
— Beginnen Sie mit einfachen, kompakten Motiven (unter 50 mm) auf stabilem, nicht dehnbarem Stoff.
— Nie mehr als 2 Tatami-Schichten übereinander sticken — die Stickerei wird sonst hart und Nadeln bre-

chen.
— Satinstiche nicht schmaler als 1,5 mm und nicht breiter als 6 mm (bei Standardgarn der Stärke 40).
— Keine Schriftarten manuell digitalisieren — das Beschriftungsmodul von Ink/Stitch verwenden.

Inkscape
— Immer die Anzeige der Konturrichtung aktivieren (Bearbeiten → Einstellungen → Werkzeuge →

Knotenwerkzeug).
— Importierte SVG-Dateien vor der Parametrisierung bereinigen : Überlagerungen entfernen, Polygone

schließen, Objekte in Pfade umwandeln.
— Die SVG-Datei regelmäßig speichern (Strg+S) — Ink/Stitch kann bei Fehlern abstürzen.

14 Links
14.1 Offizielles Handbuch

— https://inkstitch.org/de/docs/stitch-library/ (Stichbibliothek), z. B. :

https://inkstitch.org/de/docs/stitch-library/
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— https://inkstitch.org/de/docs/stitches/fill-stitch/ (Füllstich)
— https://inkstitch.org/de/docs/stitches/running-stitch/ (Geradstich)
— https://inkstitch.org/de/docs/stitches/satin-column/ (Satin-Kolonne)

— Werkzeuge und Benutzeroberfläche, z. B. :
— https://inkstitch.org/de/docs/fill-tools/ (Füllstich-Werkzeuge)
— https://inkstitch.org/de/docs/satin-tools/ (Satin-Werkzeuge)

14.2 Unsere Ressourcen
— Artikel zur Maschinenstickerei in diesemWiki20

Quelldateien und stickbare Dateien :
— Emoji-Dateien21, indexiert in der Tabelle Liste des emojis à broder 22

Links zu Tutorials undWorkshops auf Französisch :
— Guide de tutoriels de broderie machine23

14.3 Externe Ressourcen
Software (unbedingt zu installieren) :

— Inkscape24

— Ink/Stitch25

Emoji-Ressourcen :

— keyboard.cool26 — SVG-Code zum Kopieren und Einfügen
— Twemoji bei Iconify27 — SVG-Code zum Kopieren und Einfügen

Clipart :

— SVG Repo 28 — über 500 000 kostenlose SVG-Vektoren und Icons
— Undraw29 — SVG-Illustrationen, MIT-Lizenz
— ManyPixels30 — SVG-Illustrationen, regelmäßig aktualisiert
— Openclipart31 — Public Domain (CC0), große Auswahl an dekorativen Motiven
— Freepik32 — große Sammlung von SVG-Vektoren
— The Noun Project33 — Icons und einfache Formen
— Pixabay34 — SVG-Vektoren, CC0-Lizenz
— Wikimedia Commons35 — freie SVGs, viele historische und wissenschaftliche Illustrationen

Bitte die Lizenzbedingungen vor der Verwendung prüfen.

20. https://w.arbores.tech/wiki/Category:Maschinenstickerei
21. https://arbores.tech/e/e/
22. https://edutechwiki.unige.ch/fr/Liste_des_emojis_%C3%A0_broder
23. https://edutechwiki.unige.ch/fr/Guide_de_tutoriels_de_broderie_machine
24. https://inkscape.org/
25. https://inkstitch.org/
26. https://keyboard.cool/db
27. https://icon-sets.iconify.design/twemoji/
28. https://svgrepo.com
29. https://undraw.co
30. https://www.manypixels.co/gallery
31. https://openclipart.org
32. https://www.freepik.com
33. https://thenounproject.com
34. https://pixabay.com
35. https://commons.wikimedia.org/wiki/Category:SVG_files

https://inkstitch.org/de/docs/stitches/fill-stitch/
https://inkstitch.org/de/docs/stitches/running-stitch/
https://inkstitch.org/de/docs/stitches/satin-column/
https://inkstitch.org/de/docs/fill-tools/
https://inkstitch.org/de/docs/satin-tools/
https://w.arbores.tech/wiki/Category:Maschinenstickerei
https://arbores.tech/e/e/
https://edutechwiki.unige.ch/fr/Liste_des_emojis_%C3%A0_broder
https://edutechwiki.unige.ch/fr/Guide_de_tutoriels_de_broderie_machine
https://inkscape.org/
https://inkstitch.org/
https://keyboard.cool/db
https://icon-sets.iconify.design/twemoji/
https://svgrepo.com
https://undraw.co
https://www.manypixels.co/gallery
https://openclipart.org
https://www.freepik.com
https://thenounproject.com
https://pixabay.com
https://commons.wikimedia.org/wiki/Category:SVG_files
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